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For questions regarding service or technical information contact: 
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strictly forbidden. This manual may not be reproduced in whole or in part by any means whatsoever without the 
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Preface and Safety 
© 2023 MAGNETEK 
 
All rights reserved. This notice applies to all copyrighted materials included with this product, including, but not 
limited to, this manual. This manual is intended for the sole use of the persons to whom it was provided, and any 
unauthorized distribution of the manual or dispersal of its contents is strictly forbidden. This manual may not be 
reproduced in whole or in part by any means whatsoever without the expressed written permission of Magnetek. 
 
IMPULSE®•Link 5 software is copyrighted by Magnetek. All rights reserved. 

 

Product Safety Information 

Magnetek® offers a broad range of radio remote control products, control products and adjustable frequency drives, 
industrial braking systems, and power delivery products for material handling applications. This manual has been 
prepared by Magnetek to provide information and recommendations for the installation, use, operation and service 
of Magnetek’s products and systems (Magnetek Products). Anyone who uses, operates, maintains, services, 
installs, or owns Magnetek products should know, understand, and follow the instructions and safety 
recommendations in this manual for Magnetek products. 
 
The recommendations in this manual do not take precedence over any of the following requirements relating to 
cranes, hoists, lifting devices or other equipment which use or include Magnetek products: 
 

• Instructions, manuals, and safety warnings of the manufacturers of the equipment where the Magnetek 
Products are used, 

• Plant safety rules and procedures of the employers and the owners of the facilities where the Magnetek 
Products are being used, 

• Regulations issued by the Occupational Health and Safety Administration (OSHA), 

• Applicable local, state, provincial, or federal codes, ordinances, standards, and requirements, or 

• Safety standards and practices for the industries in which Magnetek Products are used. 
 
This manual does not include or address the specific instructions and safety warnings of these manufacturers or 
any of the other requirements listed above. It is the responsibility of the owners, users, and operators of the 
Magnetek Products to know, understand and follow all these requirements. It is the responsibility of the employer 
to make its employees aware of all the above listed requirements and to make certain that all operators are properly 
trained.  
 
No one should use Magnetek Products prior to becoming familiar with and being trained in these requirements and 
the instructions and safety recommendations for this manual. 
 

Product Warranty Information 

For information on Magnetek’s product warranties by product type, please visit the Magnetek website at 
www.cmco.com/magnetek.  
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DANGER, WARNING, CAUTION, and NOTE Statements 

Read and understand this manual before installing, operating, or servicing this product.  
 
The following conventions indicate safety messages in this manual. Failure to heed these messages could cause 
fatal injury or damage products and related equipment and systems. 
 

DANGER 
DANGER indicates an imminently hazardous situation that, if not avoided, will result in death or serious injury. 
This signal word is to be limited to the most extreme situations. 

 

WARNING 
WARNING indicates a potentially hazardous situation that, if not avoided, could result in death or serious injury. 

 

CAUTION 
CAUTION indicates a potentially hazardous situation that, if not avoided, could result in minor or moderate injury. 
It may also be used to alert against unsafe practices. 

 
NOTE: A NOTE statement is used to notify people of installation, operation, programming, or 

maintenance information that is important, but not hazard-related. 
 

WARNING 
Failure to observe these and other precautions indicated in this manual will expose the user to high voltages, 
resulting in serious injury or death. Damage to equipment may also occur. 
•  Read this user manual in its entirety before installing IMPULSE•Link 5 software. 
•  DO NOT connect or disconnect wiring or perform signal checks while the electrical power is ON. 
•  Improper programming of a drive with this software can lead to unexpected, undesirable, or unsafe operation or 
performance of the drive. 

 
DISCLAIMERS: No patent liability is assumed with respect to the use of the information contained herein. 

Moreover, Magnetek is constantly improving its high-quality product; therefore, the information contained in this 

manual is subject to change without notice. Every precaution has been taken in the preparation of this document. 

Nevertheless, Magnetek assumes no responsibility for errors or omissions. Neither is any liability assumed for 

damages resulting from the use of the information contained in this publication. 

 

Disposal Requirements for Waste and Electronic Equipment 

NOTICE: 
Electrical and electronic equipment can contain harmful substances that can affect the environment and human 
health.  
 
WEEE (Waste of Electrical and Electronic Equipment): The symbol for the separated disposal of electrical and 
electronic equipment is a crossed-out waste bin on wheels (Directive 2002/96/EC waste and Electrical 
Equipment). 
 
You must not dispose any electrical and electronic equipment marked with this symbol (battery-operated electrical 
appliances, measurement equipment, light bulbs, etc.) in the domestic waste but dispose of those separately. 
Always use the waste return and collection systems locally available and contribute to the reuse, recycling, and all 
other forms of use for waste electrical and electronic equipment. 
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1. Introduction 

1.1 Overview 

IMPULSE•Link 5 (IL5) is a Windows® based software package to assist users in the setup and maintenance of 
Magnetek AC and DC drives. The software is available for free in a read-only mode called “Viewer.”. Advanced 
features can be unlocked in the Professional version by purchasing a USB software licensing dongle.  
 
The free Viewer version of IMPULSE•Link 5 interacts with the DataLogger Series 4 (DLS4) keypad.  
Through a USB connection from a DLS4 to a host computer, a user can: 
 

• View stored drive parameters. 

• See Run, Alarm, and Fault history. 

• View recorded trend data. 

• Open legacy Impulse Link 4.1 parameter files of type .par and IL5 Parameter file of type .parx. 
 
The Professional version offers the above and much more: 
 

• Find drives over hardwired serial COM ports, industrial Ethernet network or Wireless Diagnostics 
System (WDS)  

• Read and write drive parameters. 

• Monitor real-time Run status, Alarms, and Faults on multiple drives at the same time. 

• Automatically discover connected drives and generate communication profiles using the Find Drives 
feature. 

 
 

IMPULSE•Link 5 Version Differences 

 
 
 
 
 
 
 
 
 
 
 

 

 
 
 
  

Feature IL5 Viewer IL5 Professional 

Wired Serial COM ports    × 

Industrial Ethernet Connectivity  × 

Wireless Diagnostics System (WDS) Connectivity  × 

Drive Discovery  × 

Create & Modify Parameters  × 

Live Monitoring & Datalogging   × 

View Parameter Files × × 

Save Parameters × × 

Compare Parameters × × 

View Event Files × × 

View Trend Files × × 
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1.2 Professional Kit Contents 

 
 

 

 

 

 

 

 

1.3 Wireless Diagnostic System (WDS) Option 

 
An optional WDS hardware system is available to connect drives wirelessly, but not required. WDS 
allows up to 31 drives to connect to a single Remote Unit. Multiple Remote Units can connect to a 
single Base Unit. 
 

 
 
 
 
 

 

1.4 Industrial Communication Options 

 
IL5 Professional can connect with IMPULSE•Series 5, Series 4, and G+ Mini communication option cards. 
 

 
 
 
 
 
 
 
 
 
 

 

1.5 System Requirements  

 

• 1.5 GHz processor or better 

• 2 GB RAM (minimum); 4 GB (recommended) 

• Windows 10, Windows 11 Operating System 

• Available USB port 
 

  

IMPULSE•Link 5 Professional Kit (IL5-PRO-KIT) Part Number 

IL5 Software Installer USB Flash Drive IL5-SOFTWARE-USB 

Unikey USB Software Licensing Key IL5-PRO-KEY 

Series 4/Series 3/G+ Mini: RJ45-to-Serial Adapter CABLE-RJ45-DB9F 

Series 4/Series 3/G+ Mini: Serial-to-USB Adapter ADAPTER-DB9M-USBA 

Series 5: USB Cable CABLE-USBA-USBMINIB 

DDC-S2 / DMC-S2: USB Cable  CABLE-USBA-USBMICROB 

DSD: RJ12-to-RJ12 Cable CABLE-RJ12-RJ12 

DSD: RJ12-to-DB9F Adapter ADAPTER-RJ12-DB9F 

Wireless Diagnostics System (WDS) Part Number 

Base Unit WDS-BASE 

Remote Unit (AC Input) WDS-REMOTE 

Industrial Communication Option Cards Part Number 

EtherNet/IP SI-EN3 

EtherNet/IP (Dual-Port) SI-EN3D 

Modbus TCP/IP SI-EM3 

Modbus TCP/IP (Dual-Port) SI-EM3D 

PROFINET SI-EP3 

PROFIBUS SI-P3 
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1.6 Supported Drives 

IMPULSE•Link 5 supports these Magnetek drives: 
 

• IMPULSE®•G+/VG+ Series 3  

• IMPULSE®•G+/VG+ Series 4 

• IMPULSE®•G+/VG+ Series 5 

• IMPULSE®•G+ Mini 

• IMPULSE®•D+ HHP 

• OmniPulse® DDC Series 1 

• OmniPulse® DDC Series 2 (includes built-in *Ethernet port) 

• OmniPulse® DSD 

• MagnePulse® DMC Series 1 

• MagnePulse® DMC Series 2 
 
*DDC-S2 Ethernet compatibility requires firmware 44301 or above. 
 
Notes: 

• Use the included adapter for serial connections to drives over a USB COM port.  

• “Scan Ethernet network” communication method requires installation of a separate EtherNet/IP option 
card on IMPULSE drives.  Refer to Section 1.4 
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2. Installation Notes 
The IMPULSE•Link 5 installer is located on the USB flash drive that comes with the DataLogger Series 4 kit and 
with the IL5 Professional kit. It is also available for download on the CMCO website: 
https://www.cmco.com/en-us/software-downloads/. 
 
NOTE: Administrative privileges are required to install and/or update the software. Please make sure to log 

onto an administrator account before installation. 

 

To install IMPULSE•Link 5 on a PC: 

1. Insert the IL5 installer flash drive into a USB port on a PC and run ImpulseLink5_Install.exe. 
2. When complete, IMPULSE•Link 5 will automatically launch. 
3. To enable IL5 Professional, insert the Unikey dongle into a USB port on the PC. 
4. Connect the drive to your PC using the proper cable(s) provided (refer to the Appendix C). 

 
 

 
A Windows Security warning may pop up during the initial installation, with the message that IMPULSE•Link 5 
would like to install device drivers. 
 

 
 

Figure 1: Windows Security Warning 

The driver software is for the DataLogger Series 4. It is not required for installing or running IMPULSE•Link 5 
Viewer or Professional; however, failure to install the driver will result in not being able to update the DataLogger.  
 
NOTE: To ensure full functionality, select “Install” and proceed with the installation. 
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3. Quick Start 

3.1 Using Viewer Version 

 

 

Figure 2: IMPULSE•Link 5 Viewer – Start Screen  
 

3.1.1  File Tab 

There are several ways to open a .parx file that is saved by a DataLogger Series 4. 

• Press the “Open File” button from WELCOME page. 

• From the File tab 

• From the Parameter tab 

• From the DataLogger tab 
 

3.1.2  Parameter Tab 

• Compare 

• Convert 
 

 

Figure 3: IMPULSE•Link 5 Viewer – Parameters Screen 
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3.1.3  Datalogger Tab 

 

Figure 4: IMPULSE•Link 5 Viewer – DataLogger Screen 
 

3.1.4.  Updates Tab 

• Check for IL5 Software Updates 

• IL5 Upgrade Information 

• DDC-S2/DMC-S2 Firmware Flash Utility 

• DLS4 Firmware Flash Utility 
 

 
 

Figure 5: IMPULSE•Link 5 Viewer – Updates Screen 
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3.2 Using Professional Version 

The IMPULSE•Link 5 Welcome screen appears on start-up to allow quick access to key features and functions 

through single-click buttons. Clicking the Home button returns to the Welcome screen.  From this screen, users 

can automatically discover drives (Find Drives), create new Communication Profiles (New File), read parameters, 

open a Parameter file, or monitor drives. 

 
 

Figure 6:  IMPULSE•Link 5 Professional – Start Screen with USB Dongle Inserted 

 

3.2.1  Find Drives 

Step 1: Press the “Find Drives” button on WELCOME page. 

Step 2: Check desired scan type boxes located on the top-right side of your screen, e.g., Scan Ethernet network 

 

Figure 7:  IMPULSE•Link 5 Professional – Find Drives 
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Select WDS, Ethernet, or COM port checkboxes to scan for the desired drives. One or more choices may be 
selected before clicking the Start button. 

 
Step 3: Click the “Start” button. 

NOTE: The Start scanner will continue to run a maximum of 15 minutes for Scan COM ports and Scan WDS, or 

until a user clicks the Stop button. The Find Drives scanner must be stopped before monitoring.  

Ethernet scans finish more rapidly, and automatically complete within a few seconds. 
 

WDS displays a moving circle containing the hexadecimal drive address of each scan attempt. Up to 31 drives 
may be connected to a single WDS Remote Unit (01-1F). 
 

 

Figure 8:  IMPULSE•Link 5 Professional – WDS Scan 

 
Communication Profiles are automatically created for each discovered drive, and they appear beneath the 
Communications section. 

 
Step 4: The “Stop” button is automatically grayed out after the scan is complete. 
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Figure 9: IMPULSE•Link 5 Professional – Stop Button 

 

Step 5: Click the “Monitor” button on the desired drive. 

 

Figure 10: IMPULSE•Link 5 Professional – Monitor Screen 
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3.2.2  Monitor Drive(s) 

3.2.2.1  Dashboard Tab 

The Monitor Dashboard tab is displayed after the Monitor button is pressed.                                            

 

Figure 11: IMPULSE•Link 5 Professional – Monitor Dashboard Screen 

 

3.2.2.2  Run Log Tab 

 

Figure 12: IMPULSE•Link 5 Professional – Run Log 
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3.2.2.3  Alarm Log Tab 

 

Figure 13: IMPULSE•Link 5 Professional – Alarms Log 
 

3.2.2.4 Fault Log Tab 

 

Figure 14: IMPULSE•Link 5 Professional – Fault Log 
 

3.2.2.5 Save to DataLogger Format 

Press the “Save” button, to create a DS4_Log00.ds4 file and save it to the local drive on the PC.   

Note: Make sure to press the Save button before you press the Stop button or switch to other screens.  

Otherwise, Runs/Alarms/Faults events will be closed without saving to a file.  
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Figure 15: IMPULSE•Link 5 Professional – Save Button 
 
 

3.2.3  Read Parameters 

There are two methods to read parameters. 
 
Method 1 
Press the “Read” button on the Find Drives screen. 
 

 
 

Figure 16: IMPULSE•Link 5 Professional – Read Parameters 
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Method 2 

Press the “Read” button on the Parameters tab. 

 

Figure 17: IMPULSE•Link 5 Professional – Read Parameters 

 

3.2.4  New Parameter Set 

Press the “New” button or press the New+ icon of the File tab. 
 

 

Figure 18: IMPULSE•Link 5 Professional – Create Parameters 
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3.2.5  Datalogger Series 4 

When connected to a PC running IMPULSE•Link, the Datalogger Series 4 will be automatically detected and 

show up in the Drive Workspace.  

Step 1: 
Connect DataLogger (DLS4) to a PC using a micro-USB cable. 

Its part number is CABLE-USBA-USBMICROB 

 

Figure 19: IMPULSE•Link 5 Professional – DataLogger 
 

Step 2: 

Select a file under Drive Workspace to view parameters, events, and trends.   
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4. Viewer and Professional Common Navigation 
Both IL5 Viewer and Professional provide functions for viewing Parameter files, Drive Events, and Trend data. The 
following is a summary of the functions that can be accessed from the navigation toolbar using either version. 
 
NOTE: IMPULSE•Link 5 will default to the Parameters tab on startup if a DataLogger is not connected to the PC. 

Once a DataLogger is connected, it will automatically switch to the DataLogger tab, and the Workspace will 
populate with the files currently loaded on the DLS4. 

 
 

4.1 File Tab 

 

 
 

Figure 20: IMPULSE•Link 5 – File Tab 
 
 

Open – Opens parameter, DataLogger, or Trend files (Alt-F-O) 
 
Recent – Displays files that have been recently accessed (Alt-F-R) 
 
Print – There are two files that can be printed, .ds4 file or parx file. 
ds4 file is saved by the Professional version Monitor/Save feature. That includes Runs, Alarms or Faults. 
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A parx file is saved by a DataLogger.  A parx file include all active parameter (Alt-F-P). 
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4.2 Parameter Tab 

The Parameters tab allows the opening, closing, and printing of parameters, DataLogger files, or Trend files.  
 
 

 

Figure 21: Parameters Tab 

4.2.1 File Operations 

• New – Create a Parameter file. 

• Open – Open a Parameter, DataLogger, or Trend file. 

• Close – Close an active Parameter, DataLogger, or Trend file. 

• Print – Print the active view (Ctrl-P) 

• Save and Save As – Save parameters, events, or trends to a file.   
 
The Save As button is context sensitive depending on which item is selected while viewing a dls4. If a 
user selects Trends, the Save As will default to saving .ts4 files, for example. If a user selects Events, the 
Save As button will default to saving .ds4 files. The Parameters tab Save and Save As buttons are greyed 
out if a Monitor is selected. The monitor dashboard contains a non-greyed out Save button in that 
situation. 

 

4.2.2 Maintenance 

• Read – Read parameters from a drive. 

• Write – Write parameters to a drive. 
 

4.2.3 Tools  

• Compare – Allows comparison between two different Parameter files. 
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Figure 22: Tools Tab – Compare Parameters 

 

 

Figure 23: Tools Tab – Comparation Difference 

When there are differences between two files, see color scheme section in this document. 
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• Convert – Parameter file conversion from one firmware version to another (must be same drive series).   
 

 

Figure 24: Tools Tab – Convert Parameters 

 

• Export – Export an open Parameter file to a CSV file.  Make sure to choose the correct parameters you 
would like to export. 
 

 

Figure 25: Tools Tab – Export 
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4.3 DataLogger Tab 

 
The DataLogger tab is used to manage DataLogger Drive Events and Trend files as well as update DataLogger 
firmware. These events and trends can be viewed when the Parameters or DataLogger tab is selected. 

 
 

 

Figure 26: DataLogger Tab and Workspace 

 
Open – Opens a Parameter, Drive Event, or Trend file. 
 
Close – Closes an active Parameter, Drive Events, or Trend file. 
 
Select New Trend – Opens window to select a different Trend file. 
 
Print – Print the active data shown in the View Window when a trend is selected. 
 
Backup Device – Back up data from the DLS4 to a PC location (determined by the user). 
 
Update Firmware – Used to update the DataLogger Series 4 firmware. 
 
Drive Workspace – Displays data loaded when the DataLogger is connected to the PC’s USB port. 
 
View Window – Displays a list of parameters (shown), Drive Events, or Trend files. 
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4.4 Parameter File Display 

Parameter files can be viewed by choosing a file from the workspace tree or browsing for a Parameter file stored 
on a PC.   
 

4.4.1 Parameter Value Text Color 

Parameters may be displayed with color coding. Various colors are used to identify a condition that may 
require further action. The table below displays the colors used, their meanings, and their descriptions. 

 

Color Meaning Description 

Blue 
Modified 
Constant 

A parameter with blue text indicates the value is 
different than its default setting. 

Gray Read-Only 

A parameter that is grayed-out is a parameter that 
cannot be modified, or the access level of the current 
Parameter set is lower than what is needed for that 
specific parameter (i.e., changing the parameter from 
the drive keypad would not be allowed with the current 
access level). 

 
Table 1: Parameter Value Text Color 

 

4.5 Workspace 

4.5.1 DataLogger Parameter File Sets 

 
The DataLogger Series 4 can store up to 11 Parameter sets. These sets are stored in “slots” numbered from  
0 to 10 and located in the internal memory with the file’s names PrmSet00.parx to PrmSet10.parx.  
 
When the DLS4 is connected to the PC, the software will associate these Parameter files with the model of 
drive in the Workspace. Parameter set 00 contains the Parameter file from the most recent drive the DataLogger 
was connected to. The name of these files can be changed in the DLS4 (see Rename Parameter Data section 
in the DataLogger Series 4 Instruction Manual) and will appear in the Workspace shown in Figure 27. 

 

 

Figure 27: DataLogger Parameter File Sets 
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4.5.2 Events 

 
Events are used to view Run history, Fault history, and Alarm history of a drive.  When an event is recorded, 
the DLS4 will gather detailed information about the state of the drive.  
 
The DataLogger Series 4 can log:  

 

• 5000 Run events 

• 400 Alarm events 

• 400 Fault events 

• Approximately 300 hours of monitor data (U01-01 – U01-12, plus up to 10 selectable monitors) 

• 11 Parameter sets 
 

The information for Runs, Alarms, and Faults can be viewed by selecting Events under the drive in the 
Workspace tree. 

 

 
Figure 28: Events 

 
 

4.5.3 Trends 

Drive status information is collected by a DataLogger Series 4 and can be charted and viewed in the Trends 
section of IMPULSE•Link 5. This data can be used to analyze drive issues during operation such as motor 
overload.   
 
Trend files are automatically generated on power-up of the DLS4, and at the start of every hour. To view a 
trend, click on “Trends” under the desired drive. A Date Dialog Box will appear.  
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Figure 29: Trends 

 

Figure 30: Date Dialog Box 

 
The Date Dialog Box is used to navigate to the time of the trend. Click on a date to show all trends for that day. 
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Figure 31: Selecting the Date 

All the trends for this date will be shown under “Available Times” on the right. Click on the date/time to highlight 
the trend to view and then choose “Load.” 

 

Figure 32: Selecting the Desired Trend 

 
NOTE: This may take several seconds to open depending on the trend length. 
NOTE: Trends can also be found in the “Trend” folder in the DataLogger Series 4 internal memory. See 

the DataLogger Series 4 manual for more information. 
 

4.5.4 Runs 

When the DLS4 detects a run, it increments the run counter and begins to take average and peak values of the 
Monitors being logged. It also logs how long the run remains active. When the run has ended, this information 
is written to the internal memory. If the run ended due to a fault, the reference to that fault gets linked with the 
run. A reference to the last alarm (if any) that occurred during the run is also stored. The DLS4 records 
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numerous pieces of data at the end of the run event. Each of these can be turned ON or OFF for viewing 
purposes. For example, when “Model” is deselected, it will not be displayed in the Events window.  
 
Table 2 shows the various data that is collected. 
 

Name Description 

Run # Number of Runs recorded by the DLS4. 

Date Date the Run event ended [Day/Month/Year]. 

Time Time the Run event ended [Hour:Minute:Second]. 

Direction “FWD” or “REV”. 

Duration [sec] Amount of time the Run command was active. 

Avg DC Bus [VDC] Average DC Bus Voltage during the Run. 

Peak DC Bus [VDC] Peak DC Bus Voltage during the run. 

Avg Iout [A] Average output current to the motor. 

Peak Iout [A] Peak output current to the motor. 

Avg Fout [Hz] Average output frequency of the drive. 

Peak Fout [Hz] Peak output frequency of the drive. 

Avg Mtr Speed [Hz] 1 Average speed of the motor. 

Peak Mtr Speed [Hz] 1 Peak speed of the motor. 

Avg Mtr Torque [%] 1 Average torque applied to the motor during the Run. 
Peak Mtr Torque [%] 1 Peak torque in the motor. 

Heatsink [°C] Heatsink temperature when the Run event ended. 

Last Alarm Last Alarm recorded. 

Last Fault Last Fault recorded. 

Control Control method of the drive. 

Motion Motion of the drive. 
 

1 Only valid when the control method is Open Loop Vector or Flux Vector. 
 

Table 2: Run Data – AC Drive 

 

4.5.5 Alarms 

If an Alarm is detected during a Run, it will be logged under the Alarms tab. Each data point can be turned ON 
or OFF for viewing purposes. For example, when “Model” is deselected, it will not be displayed in the Events 
window.  
 
Table 3 shows the various data that is collected.  

 
 

Name Description 

Alarm # Alarm number in the DLS4. 

Alarm Name of the Alarm posted at the end of the Run event. 

Date Date the Alarm occurred [Day/Month/Year]. 

Time Time the Alarm occurred [Hour:Minute:Second]. 

Assoc. Run # Associated Run number that the Alarm occurred in. 

Control Control method of the drive. 

Motion Motion of the drive. 

 
Table 3: Alarm Data 

 

4.5.6 Faults 

 
If a Fault is detected during a Run, it will be logged under the Faults tab. Each data point can be turned ON or 
OFF for viewing purposes. For example, when “Model” is deselected, it will not be displayed in the Events 
window.  
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Table 4 shows the various data that is collected.  
 

Name Description 

Fault # Number of the Fault stored in the DLS4.  

Date Date the Fault occurred [Day/Month/Year]. 

Time Time the Fault occurred [Hour:Minute:Second]. 

Assoc. Run # Associated Run number that the Fault occurred in. 

Fault Name of the Fault. 

Fref [Hz] Frequency reference at the time of the Fault. 

Fout [Hz] Output frequency at the time of the Fault. 

Iout [A] Output current at the time of the Fault. 

Motor Speed [Hz] Motor speed at the time of the Fault. 

Vout [VAC] Output voltage at the time of the Fault. 

DC Bus [VDC] Voltage on the DC Bus at the time of the Fault. 

Power Out [HP] 1 Output power at the time of the Fault. 

T-ref [%] 1  Torque reference at the time of the Fault. 

Input Terminal Status Status of the input terminals at the time of the Fault. 

Output Terminal Status Status of the output terminals at the time of the Fault. 

Inverter Status Status of the drive at the time of the Fault. 

Elapsed Time [Hr] Time since the last Fault was recorded. 

Heatsink [°C] Heatsink temperature at the time of the Fault. 

Control Control method of the drive. 

Motion Motion of the drive. 

 
1 Only valid when the control method is Open Loop Vector or Flux Vector. 

 
Table 4: Fault Data – AC Drive 

 
 

4.6 Trend Analysis 

4.6.1 Trend Navigation 

 
Trend view will display both analog and digital signals from the drive as well as signal names and ranges. These 
signals can be selected in the Signal Selection pane. 
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Figure 33: Trend Navigation Overview 

 

4.6.2 Trend File Information 

The Trend file data displays information about the Trend file being viewed. 
 

 
 

Figure 34: Trend File Information 

NOTE: The “Date” format is based on the PC’s settings. 
 

4.6.3 Signal Name Select 

Analog and digital signals can be selected or deselected from the Signal Name Select pane. The following 
shows the default selections when a trend is first viewed. 
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Figure 35: Signal Name Select Pane 
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4.6.4 Mouse Tooltips 

Hovering the mouse pointer over a signal in the Signal Name Select pane will display additional information 
about that signal, such as the monitor name or meaning, terminal number, and programmed parameter value. 

 

 
 

Figure 36: Mouse Tooltip Examples 

 
 

4.6.5 Signal Names – Analog 

When an analog signal is selected, the trend will populate the graph with this data and display the signal name 
with the upper and lower limits for that monitor. The color of the name is the same as the color of the data 
graphed. 

 

 
 

Figure 37: Analog Signal Names 
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4.6.6 Signal Names – Digital 

When a Multi-Function Digital Input (MFDI) or Multi-Function Digital Output (MFDO) signal is selected, the trend 
will populate the graph and display the signal name. A one (1) or a zero (0) is used to identify whether the 
input/output is on (closed) or off (open). The color of the name is the same as the color of the data graphed. 

 

 

Figure 38: Digital Signal Names 

 

4.6.7 Time 

Time is displayed on the bottom in HH:MM:SS using 24-hour format. 
 
 

4.6.8 Trackball 

The trackball displays values for each of the analog signals when the mouse pointer is hovered over the area 
where the analog signals are shown. The details shown are the values recorded by the DLS4 for each signal. 
The colors of the names are the same as the color of the signal in the graph.  

 

 
 

Figure 39: Trackball Details 
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4.6.9 Scrollbar Navigation 

IMPULSE•Link 5 provides a proportional scrollbar to navigate through a Trend file. The scrollbar is used to 
zoom in/out or move from the beginning/end of the Trend file.  

 

4.6.10 Sliding the Scrollbar 

Navigation from the beginning to the end of a Trend file is done by left-clicking on the scrollbar and sliding the 
scrollbar left or right. 

 

 
 

Figure 40: Sliding the Scrollbar 
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4.6.11 Zoom 

Zooming in or out on a trend can be done with the scrollbar, mouse, or mouse wheel.  
 

1. Scrollbar: Left-click on the outside edge of the scrollbar, then drag to expand or contract view. Below is an 
example of zooming out. The cursor turns into a double-sided arrow. 

 

 
 

Figure 41: Using the Scrollbar 

 
2. Mouse wheel: Position the mouse over the desired area on the trend to zoom in/out from. Use the mouse 

wheel to zoom in or out on the trend at that position on the graph. 
3. Mouse: With the mouse, left-click and hold on the desired area of the graph and then drag the mouse to 

zoom in. 
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4.7 Printing 

IMPULSE•Link 5 can print Parameter sets, Event information, and Trending data.  
 

4.7.1 Parameter Data 

To print parameter data, go to the Parameters tab and select the Parameter set from the Workspace. 
 

 
 

Figure 42: Selecting the Parameter Set 

 
 

Click the Print icon, which will bring up the IMPULSE•Link 5 Print dialog. 
 

 
 

Figure 43: Print Preview of the Parameter Set 
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The initial “Print” data is controlled by the Parameter view. Changing the view in the Parameter tab from "All" 
to the desired view (parameter groups, modified parameters, etc.) will change the data available for printing. 

 

 
 

Figure 44: Selecting a Specific Parameter Group 

 
 

To print select parameters, shift-click the desired block of rows to print, or ctrl-click to select non-contiguous 
rows. If a parameter was selected in error, simply ctrl-click that parameter to remove it from the selected 
parameters (it should no longer be highlighted). Then click on the Print icon to open the Print dialog and click 
the "Selected" option before printing. 

 

 
 

Figure 45: Highlighting Select Parameters 
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4.7.2 Events 

 
To print Event data, go to the DataLogger tab and select the Event set to be printed from the workspace. 

 

 
 

Figure 46: Selecting an Event 

Click the Print icon, which will bring up the IMPULSE•Link 5 Print dialog. 
 

 
 

Figure 47: Print Preview of the Event 

 
 
 

Use the scroll arrows in the Print preview to see Runs, Alarms, and/or Faults. 
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Figure 48:  Print Alarms 
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Figure 49: Selecting Specific Runs, Alarms, and/or Faults 

 

 
 

Figure 50: Print Preview of Selected Data 

 
NOTE: The selection options for the events under the DataLogger tab do not control what will print. 

 

  



43 
 

4.7.3 Trends 

To print Trend data, go to the DataLogger tab and select the trend to be printed from the workspace. 
 

 
 

Figure 51: Selecting the Trend 

 
Click the Print icon, which will bring up the IMPULSE•Link 5 Print dialog. 

 

 
 

Figure 52: Printing the Trend 

 
The printed data is based on the view in the main window, so be sure to adjust the view as necessary before 
printing (zooming on the desired data, adding, and removing signals as necessary, etc.). 
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4.8 Updates Tab 

Viewer Update Tab 
 

 

Figure 53: IMPULSE•Link 5 Viewer – Updates Tab 

 
Professional Update Tab 

 

 
 

Figure 54: IMPULSE•Link 5 Professional – Updates Tab 
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4.8.1 Check for IL5 Software Updates 

Additional features and enhancements may be released without notice.  
 
The software can be downloaded from the CMCO website at https://www.cmco.com/en-us/software-downloads/ 
 
To check for updates after IMPULSE•Link 5 software has been installed: 
 

1. Click the Check for Updates button under the Updates tab.  
 
 

 
 
 
 

If an update is available, it will prompt the user to install the update. The computer must have internet access. 
 

 

 
 
 

If the user chooses to install the update immediately, the Web Update Check Client will launch. 

 

 
 
 

https://www.cmco.com/en-us/software-downloads/
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The installer may request a core prerequisite. 
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Once IMPULSE•Link 5 is done installing the update, it will automatically relaunch. 
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4.8.2 DDC-S2/DMC-S2 Firmware Flash Utility 

 
The OmniPulse DDC Series 2 (DDC-S2) and MagnePulse DMC Series 2 (DMC-S2) Flash Utility allows a user to 

update DDC-S2 or DMC-S2 Control Board firmware using the provided cables (P/N: CABLE-RJ45-DB9F and 

ADAPTER-DB9M-USBA). 

The firmware can be downloaded from the CMCO website at https://www.cmco.com/en-us/software-downloads/ 

To update the firmware, do the following: 

1. Click “Load FW” button. 

2. Select firmware file. 

3. Click “Open” button. 

4. Select Com port. 

5. Click “Update Firmware” button. 

 

Figure 55: OmniPulse DDC-S2 & MagnePulse DMC-S2 Flash Utility 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://www.cmco.com/en-us/software-downloads/
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4.8.3  Update DLS4 Firmware 

IMPULSE•Link 5 can update the firmware in the DataLogger Series 4 (DLS4) to incorporate any new features and 
enhancements to the DLS4. If the PC has internet, the newest version of firmware for the DLS4 will be automatically 
installed on the PC using the Check for Updates button.  
 
The firmware can be downloaded from the CMCO website at https://www.cmco.com/en-us/software-downloads/ 

Once the firmware is saved to the PC, do the following: 
 

1. Connect the DataLogger Series 4 to the PC using a USB cable. Press the DLS4 keypad’s F1 and F2 keys 
simultaneously until the “READY FOR UPDATE” message appears. 

 

 
 

Figure 56: DataLogger Series 4 Screen – Ready for Update 
 

2. Go to the DataLogger tab. 
 

3. Click on the “Update DLS4 Firmware” icon in IMPULSE•Link 5. 
 

 

 

Figure 57: The Update Firmware Icon 

 
4. After the firmware is updated, the version will be displayed on the main screen of the DLS4. 

 

 
 

Figure 58: DataLogger Series 4 Main Screen 

https://www.cmco.com/en-us/software-downloads/
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4.9 Help Tab 

The Help tab contains information about IMPULSE•Link 5 Viewer and Professional, as well as user resources. 
 

 
 

Figure 59: The Help Tab 

 
About – Opens a window which includes displays the software version, build, and the copyright date. 
 

  
 

Figure 60: About IMPULSE•Link 5 

 
User Manual – Downloads the IMPULSE•Link 5 User Manual from the internet, provided the PC is connected. 
 
Magnetek Website – Opens Magnetek’s main website (http://www.cmco.com/magnetek).  
 

Contact Us – Opens a window containing the Technical Support number and a link to the Field Service email. 

http://www.cmco.com/magnetek
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Appendices 

Appendix A: Wiring for Wireless Diagnostic System (WDS) Base Unit 
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Appendix B:  Wiring for Wireless Diagnostic System (WDS) Remote Unit  

 

IMPULSE G+/VG+ Series 3, 4, 5 and G+ Mini 

 
 

NOTE: The IMPULSE Series 5 terminal board contains D+ and D- terminals for 2-wire RS-485 communication.  

Connect D+ to T+ of the Remote Unit and D- to T-.  Change the Remote Unit DIP Switchs to 2-Wire.  
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OmniPulse DDC Series 2 & MagnePulse DMC Series 2 
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OmniPulse DDC Series 1 & MagnePulse DMC Series 1 
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OmniPulse DSD 

 


